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À lire attentivement ! Version FRANÇAISE

R4-02-06

Ce manuel contient des informations importantes sur la
sécurité pour l’installation et le fonctionnement du logiciel.
Suivre scrupuleusement ces informations pour éviter de
causer des dommages aux personnes et aux objets.

L’utilisation de ce logiciel est sujette à l’acceptation de la
licence d’utilisation.

Système d’exploitation requis : Microsoft Windows 98SE,

ME, NT SP4, 2000, XP.

Processeur : Intel Pentium 500 MHz ou supérieur

RAM : 64 MB

M O D E  D ’ E M P LO I  D U
L O G I C I E L « Mas te r  Comm »
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Licence d’utilisation  pour les usagers du logiciel "Master Comm" aka "MC"

NOTE IMPORTANTE – LIRE ATTENTIVEMENT : cette licence d’utilisation est destinée aux utilisateurs des
logiciels "MC" il y a un accord qui définit l’utilisation des logiciels  d’"ATA Srl" et de ces filiales (“ATA
Srl”),téléchargeable,ycompris le logiciel de l’ordinateur et le matériel d’impression connecté (“SOFTWARE”).
Afin de télécharger, d’installer, de copier ou d’utiliser ce LOGICIEL de n’importe quelles  manières que ce soit,
les termes établis par la présente LICENCE doivent être accèptés. Si vous n’acceptez pas les termes de la
présente LICENCE, vous n'avez pas la permission d’installer le LOGICIEL.

L’utilisation du produit "MC" ("Master Comm") requiert 3 éléments : le LOGICIEL, l’hardware "LDCOM" et un PC.
Le LOGICIEL est protégé par les lois sur les droits d’auteur et traités internationaux sur les droits  d’auteur, ainsi
que d’autres lois et traités sur la propriété intellectuelle. Le LOGICIEL n’est pas vendu, mais  seulement concédé
en utilisation, en correlation étroite avec ce document. L’hardware est protégé par divers brevets, et, est vendu,
mais le présent accord ne concerne pas la vente, lorsqu’il ne doit pas nécessairement  être vendu avec le
LOGICIEL. Le présent accord détermine les termes et les conditions, uniquement pour la LICENCE du LOGICIEL.

1. DEFINITIONS

1.1 Utilisateur.
L’utilisateur est l’entité ou l’individu qui télécharge le  LOGICIEL.

2. CONCESSION DE LICENCE

2.1 Droits et limites de la concession .
Avec le présent accord, ATA Srl concède à l’utilisateur le droit suivant, non exclusif et non transférable,
d’utilisation du LOGICIEL, avec les limites suivantes :

2.1.1 Droits.
L’utilisateur ne peut utiliser qu’une unique copie du LOGICIEL sur un seul poste et à l’exclusion de la  copie de
back-up du logiciel, ne pourra pas copier de quelque manière que ce soit le LOGICIEL. La présente LICENCE
du LOGICIEL ne peut être  partagée ou utilisée en même temps pour plusieurs PC.

2.1.3 Limites.
Défense d'inversion de l'automatisme. L’utilisateur ne pourra pas inverser, décompiler ou désassembler le
LOGICIEL, ni tenter de quelque manière que ce soit d'obtenir le code.

Défense de séparer les composants. Le LOGICIEL est concedé sous licence comme produit seul. Ces composants
ne peuvent pas être séparés pour être utilisé sur plus ordinateurs.

Défense de louer. L’utilisateur ne peut en aucun cas louer ce logiciel à une tierce personne.

3. RESILIATION

La LICENCE prendra automatiquement fin, si l’utilisateur doit ne pas respecter un des termes de la licence. Dans
ce cas, l’utilisateur devra détruire toutes les copies du LOGICIEL et tous ses composants.

4. DROITS D’AUTEUR

Licence d’utilisation du logiciel “Master
Comm”
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Tous les droits et droits d’auteur, relatifs au LOGICIEL (images, photographies, animation, écran, son, musique,
texte compris et autres renseignements incorporés dans le LOGICIEL) la documentation  imprimée qui
l’accompagne et copie quelconque du logiciel sont propriétés de  ATA Srl ou de ses fournisseurs. Le
LOGICIEL est protégé par les lois sur les droits d’auteur et par les conventions internationales. En rapport avec
ceci, l’utilisateur devra utiliser le LOGICIEL comme tout autre matériel couvert par les droits d'auteur, autorisé par
cette LICENCE et il pourra préparer une copie unique de sauvetage de secours ou d'archives du LOGICIEL.

5. DROIT APPLICABLE

6. EXCLUSION DE GARANTIE ET LIMITE DE RESPONSABILITE

6.1 EXCLUSION DE GARANTIE.
DANS LES TERMES MAXIMUM ACCORDES PAR LA LOI APPLICABLE, LE LOGICIEL EST LIVRE “EN L’ETAT ”
ET NVIDIA ET SES FOURNISSEURS EXCLUENT  TOUT AUTRE GARANTIE, EXPRESSE OU IMPLICITE,
COMPRISE, MAIS NON LIMITEE A CECI, GARANTIES RELATIVES A LA COMMERCIALISATION ET A
L’ADEQUATION DANS UN BUT PRECIS.

6.2 EXCLUSION DE RESPONSABILITE POUR LES DOMMAGES CONSECUTIFS
DANS TOUTE LA MESURE PERMISE PAR LA REGLEMENTATION  APPLICABLE, EN AUCUN CAS ATA SRL
OU SES FOURNISSEURS NE POURRONT ETRE  TENUS RESPONSABLES DE TOUT DOMMAGE  SPECIAL,
INCIDENT, INDIRECT OU CONSEQUENCIEL (Y COMPRIS, MAIS DE MANIERE NON LIMITATIVE, LES
DOMMAGES CONCERNANT LES PERTES DE BENEFICES, INTERRUPTION D’ACTIVITE, PERTES
D’INFORMATIONS RELATIVES A L’ACTIVITE  ET TOUTES AUTRES PERTES FINANCIERES), RESULTANT OU
LIE A L’UTILISATION OU A L’INCAPACITE D’UTILISER LE LOGICIEL , MEME SI  ATA SRL A ETE AVISEE  DE
L’EVENTUALITE DE TELS DOMMAGES.

7. DIVERS

Nous ne reconnaissons pas la conventions des Nations Unies sur les contrats de ventes internationaux de
biens. Si une des dispositions de la présente LICENCE doit être différée avec la loi ou ne pas correspondre
entièrement à celle-ci, une telle disposition sera appliquée avec l'étendue nécessaire  afin de correspondre  à la
loi et de la rendre applicable. Le présent accord est l’accord final, complet et exclusif entre les parties  et il
remplace toutes les conventions et les accords précédents ou  contemporains, relatifs à la matière en objet,
qu’ils soient oraux ou écrits. L’utilisateur convient qu’il n’enverra pas, ne transférera pas ou n’exportera pas le
LOGICIEL dans n’importe quel pays et qu’il n’utilisera pas le LOGICIEL par n’importe quel moyen  interdit par
l’ “United States Bureau of Export Administration” ou par n’importe quelle loi, restriction ou réglementation sur
l’exportation. La présente LICENCE pourra  être modifiée seulement par écrit, avec signature d’un responsable
autorisé d’ATA Srl.

12/Mai/2004

Licence d’utilisation du logiciel “Master
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Introduction

Introduction :

Le logiciel « Master Comm » permet de contrôler à distance (au moyen du port RS232 local ou d’un
modem PSTN) les appareils de la série « LD » reliés à une installation par RS485 (jusqu’à un maximum de
32 appareils).
Il est possible de connaître en temps réel l’état de chaque appareil , d’effectuer sa programmation,
d’afficher tous les événements et toutes les alarmes qui ont eu lieu, d’imprimer ou de réaliser des
graphiques sur l’activité de tous les appareils connectés. Il est également possible de paramétrer une
alarme SMS au moyen du modem GSM intégré qui enverra un court message à un ou plusieurs numéros de
téléphone définis.

Connexion locale et à distance :

ATTENZIONE
La procedura di installazione descritta successivamente è automatica ed è sufficiente premere -
Avanti- salvo diversamente specificato.
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Installation
Procédure d’installation

Introduire le CDROM « MasterComm » dans le lecteur.  Si la fonction d’exécution automatique du
système d’exploitation est active, le programme démarre automatiquement. Dans le cas contraire, ouvrir
le dossier du CDROM et effectuer un double clic sur l’icône « Setup ». L’installation du logiciel
« MasterComm » démarre.

L’écran de la figure 1 permet de démarrer la procédure d’installation. Cliquer sur «  Next » pour continuer.
Cliquer sur « Cancel » pour annuler.

L’écran de la figure 2 permet de personnaliser la copie d’installation. Saisir les données personnelles.
Laisser les paramètres d’utilisation du programme sur « all users » et continuer en cliquant sur « Next ».
L’écran de la figure 3 permet de spécifier un dossier d’installation différent de celui par défaut. Cliquer sur
« Next » pour continuer l’installation dans le dossier par défaut ou cliquer sur « Change » pour spécifier
un dossier d’installation différent.

figure 1

figure 2

figure 3
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figu-
re 11

Le message de la figure 11 termine l’installation du logiciel « MasterComm ». Pour exécuter le programme
immédiatement, cliquer sur « Finish ».  Pour démarrer le programme plus tard, décocher la case « Launch
Program » et cliquer sur « Finish ». Une icône de lancement du programme « MasterComm » a été créée sur
le Bureau. Effectuer un double clic sur cette icône pour exécuter le programme.

L’écran de la figure 4 résume toutes les informations relatives au processus d’installation. Pour continuer
l’installation, cliquer sur « Next ». Pour modifier les informations, cliquer sur « Back » ; pour annuler,
cliquer sur « Cancel ».

Installation

figure 4
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Configuration rapide

Une fois effectués les branchements entre le PC et le LDCOM ou les appareils de la série LD et une fois
installé le logiciel MasterComm, il est possible d’effectuer la configuration du programme. Cela est
nécessaire pour permettre au LDCOM de reconnaître les appareils qui ont été connectés et qui doivent
être contrôlés.

Si l’appareil LDCOM a déjà été configuré, suivre la procédure du point 7 pour pouvoir travailler avec les
appareils présents.

Si l’appareil LDCOM n’a pas été configuré, suivre tous les points suivants.

1. Exécuter le programme MCOMM en cliquant sur l’icône correspondante ou celle dans le menu

Démarrer -> Tous les programmes -> MasterComm

2. Sur la figure 12, sélectionner l’installation nº 1 (sauf indication contraire). Cliquer sur « OK ».

3. Il est nécessaire de spécifier le mot de passe (figure 13) pour l’accès au programme en mode
« Administrateur » (qui autorise à effectuer les modifications nécessaires). Saisir « master » (en minuscule,
sans guillemets), puis cliquer sur « OK ».

figure 12

figure 13
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4.  Sur l’écran de la figure 14, il est nécessaire d’établir si la connexion entre l’ordinateur et le LDCOM
est locale (le LDCOM est branché au PC avec un câble série) ou distante (le LDCOM est branché au PC
au moyen d’un modem).  Si la connexion s’effectue par le port série, spécifier sur quel port COM est
branché l’appareil LDCOM, vérifier que soit sélectionner « LDCOM » et non « LD », puis cliquer sur
« LOCAL ».

5.  À partir du menu « Remote Device », sélectionner « Database », puis cliquer sur « Edit PC Database
MasterComm - LDCOM » (figure 15).

Configuration rapide

figure 14

figure 15
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6.  L’écran de la figure 16 est divisé en deux sections : la section supérieure correspond à la configuration
présente dans l’appareil LDCOM relié au PC, tandis que la section inférieure représente la configuration
présente sur le PC sur lequel est exécuté le programme « MasterComm ». S’il s’agit de la première
exécution du programme, aucune donnée ne sera présente dans les deux zones.

7. La configuration suivante prévoit la connexion d’un appareil LDPH (à titre d’exemple) à l’appareil
LDCOM. Pour ajouter d’autres appareils, il suffira de répéter les points suivants.

Si l’appareil LDCOM est déjà configuré, il suffit de charger la base de données qu’il contient
en cliquant sur « LOAD DB LDCOM » (attendre le message de confirmation « configuration
ok ») et ensuite sur « LOAD DB LDCOM -> MASTERCOMM » (chargement de la base de
donnée sur le logiciel « MasterComm »). Dans la zone de configuration LDCOM (section
supérieure de la figure 16) se trouvent les appareils déjà configurés.

8. Pour ajouter un appareil, il est nécessaire de le configurer dans la zone locale (section inférieure de la
figure 16) du MasterComm, puis il faut le charger dans la base de données du LDCOM. Pour réaliser cette
configuration, cliquer sur la première case blanche appelée « ID LD » présente dans la partie inférieure de
l’écran sur la figure 16 et saisir les six chiffres qui constituent le numéro d’identification (ID) de l’appareil
(par exemple : 000001).

Pour connaître le numéro d’identification de l’appareil en cours de configuration, lire la section
« 4.Impression, Comm. » du manuel correspondant.

Par défaut, tous les appareils de la série LD possède le numéro d’identification « 000001 ». Si l’appareil
en cours de configuration est le premier de la série, il suffit de saisir le numéro d’identification par défaut
(000001).

Pour les autres appareils, il faudra spécifier un numéro d’identification différent.

figure 16

Configuration LDCOM

Configuration locale

Configuration rapide
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9.  Cliquer sur la case suivante appelée « Type LD » présente dans la partie inférieure de l’écran sur la
figure 16, puis saisir le nom de l’appareil conformément à ce qui est indiqué ci-dessous :

Si l’appareil à brancher est un LD pour PH, saisir « LDPH » (sans guillemets).
Si l’appareil à brancher est un LD pour Redox, saisir « LDRH » (sans guillemets).
Si l’appareil à brancher est un LD pour conductibilité, saisir « LDCD » (sans guillemets).
Si l’appareil à brancher est un LD pour chlore, saisir « LDCL » (sans guillemets).
Si l’appareil à brancher est un LD pour turbidité, saisir « LDTORB » (sans guillemets).
Si l’appareil à brancher est un LD CLA, saisir « LDCLA » (sans guillemets).

10. Cliquer sur la case suivante appelée « Dis. Ora » présente dans la partie inférieure de l’écran sur la
figure 16 et saisir « Y » (sans guillemets) pour afficher l’heure de l’appareil sur l’écran principal du
MasterComm ou saisir « N » pour ne pas afficher cette information.

11. Cliquer sur la case suivante appelée « Dis. Temp. » présente dans la partie inférieure de l’écran sur la
figure 16 et saisir « Y » (sans guillemets) pour afficher la température relevée par l’appareil sur l’écran
principal du MasterComm ou saisir « N » pour ne pas afficher cette information.

12. Cliquer sur la case suivante appelée « Int. Log File » présente dans la partie inférieure de l’écran sur
la figure 16 et saisir les heures et les minutes au format HH: MM pour créer à intervalles réguliers sur
l’ordinateur un fichier journal contenant les informations sur l’état de l’appareil. Laisser ce champ vide
pour désactiver cette fonction.

13. Cliquer sur la case suivante appelée « Int. Log Stampa » présente dans la partie inférieure de l’écran
sur la figure 16 et saisir les heures et les minutes au format HH: MM pour imprimer le fichier journal à
intervalles réguliers sur l’imprimante branchée l’ordinateur. Laisser ce champ vide pour désactiver cette
fonction.

14. Cliquer sur la case suivante appelée « SMS COM » présente dans la partie inférieure de l’écran sur la
figure 16 et saisir « Y » (oui) ou « N » (non) pour envoyer un SMS vers un numéro de téléphone défini en
cas de perte de connexion entre le PC et l’appareil. Pour utiliser cette fonction, il est nécessaire de
configurer la carte GSM présente à l’intérieur du modem.

15. Cliquer sur la case suivante appelée « SMS FLOW » présente dans la partie inférieure de l’écran sur la
figure 16 et saisir « Y » (oui) ou « N » (non) pour envoyer un SMS vers un numéro de téléphone défini en
cas d’absence de flux dans l’installation. Pour utiliser cette fonction, il est nécessaire de configurer la
carte GSM présente à l’intérieur du modem.

16. Cliquer sur la case suivante appelée « SMS A1 » présente dans la partie inférieure de l’écran sur la
figure 16 et saisir « Y » (oui) ou « N » (non) pour envoyer un SMS vers un numéro de téléphone défini en
cas de déclenchement de l’Alarme 1 de l’installation. Pour utiliser cette fonction, il est nécessaire de
configurer la carte GSM présente à l’intérieur du modem.

17. Cliquer sur la case suivante appelée « SMS A2 » présente dans la partie inférieure de l’écran sur la
figure 16 et saisir « Y » (oui) ou « N » (non) pour envoyer un SMS vers un numéro de téléphone défini en
cas de déclenchement de l’Alarme 2 de l’installation. Pour utiliser cette fonction, il est nécessaire de
configurer la carte GSM présente à l’intérieur du modem.

18. Cliquer sur la case suivante appelée « SMS L1 » présente dans la partie inférieure de l’écran sur la
figure 16 et saisir « Y » (oui) ou « N » (non) pour envoyer un SMS vers un numéro de téléphone défini en
cas de déclenchement de l’Alarme niveau 1 de l’installation. Pour utiliser cette fonction, il est nécessaire
de configurer la carte GSM présente à l’intérieur du modem.

Configuration rapide
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19. Cliquer sur la case suivante appelée « SMS L2 » présente dans la partie inférieure de l’écran sur la
figure 16 et saisir « Y » (oui) ou « N » (non) pour envoyer un SMS vers un numéro de téléphone défini en
cas de déclenchement de l’Alarme niveau 2 de l’installation. Pour utiliser cette fonction, il est nécessaire
de configurer la carte GSM présente à l’intérieur du modem.

Il est possible d’ajouter d’autres appareils en répétant les points de 8 à 19.
Une fois terminé la saisie des appareils, il est nécessaire de certifier la base de données en cliquant sur
« LDCOM DB CHECK ». Si aucune erreur ne se produit, cliquer sur « APPLY ».

Configuration rapide
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Description du menu « General »

Cliquer ici pour changer la liste des mots de
passe utilisateurs.

Cliquer ici pour modifier le nom et la
description des installations

Cliquer ici pour changer le temps de
rafraîchissement d’accès aux appareils

Cliquer ici pour échanger l’accès entre le
LDCOM et les appareils

Cliquer ici pour changer la langue

Cliquer ici pour fermer toutes les fenêtres.
Cliquer à nouveau pour quitter.

« Open Warning File LDCOM » (ouvrir fichiers d’alerte LDCOM).
Affiche la liste des erreurs du « MasterComm ».
Cette liste décrit le nom de l’installation et l’erreur qui s’est produite. Utiliser cette fonction pour
contrôler l’installation sélectionnée.

« Password Menu » (Gestion mot de passe).
Pour limiter l’accès au menu, il est possible de paramétrer plusieurs mots de passe jusqu’à un maximum de
3 utilisateurs. Pour modifier les mots de passe, il faut avoir l’accès « MAIN ».
Une fois définis les mots de passe, appuyer sur « >> » pour les enregistrer dans la mémoire du programme.

« Remote Installations DB » (Modification des installations).
Utiliser ce menu pour paramétrer les noms et les descriptions des installations. Un maximum de 20
installations peut être enregistré.

« Polling Time » (Temps d’invitation).
Définit le temps pour la récolte suivante d’informations pendant la phase de communication (Invitation
validée). Laisser les valeurs par défaut.

« Language » (Langue).
Cette fonction permet de changer la langue (anglais ou italien).

« EXIT » (Quitter).
Ferme toutes les fenêtres et arrête le programme.

Cliquer ici pour afficher la liste des erreurs
du journal LDCOM
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Description du menu « Remote Device »

Cliquer ici pour changer la date et l’heure du système et du
LDCOM.

Cliquer ici pour configurer ou modifier la base de données de
l’appareil

Cliquer ici pour modifier la liste des numéros de téléphone pour
la connexion à distance

Cliquer ici pour redémarrer le système LDCOM

« Date and Time » (Date et heure).
Charger la date et l’heure depuis ou vers le LDCOM pour la synchronisation des systèmes.

« Database » .
Pour utiliser correctement les instruments LDCOM/LD, il est nécessaire de définir la configuration de
l’installation. Définir tout d’abord localement la configuration des appareils en sélectionnant « Edit PC
Database » dans le sous-menu « Database ».

« LDCOM Telephone Number » (Numéros de téléphone LDCOM).
Utiliser ce menu pour ajouter des numéros de stations distantes et pour les copier vers ou depuis le
LDCOM. Il est possible d’ajouter des numéros de cellulaires pour le service d’alarme par SMS.

« Re-Boot LDCOM » (Redémarrage du LDCOM).
Utiliser cette fonction pour charger le système LDCOM (en cas de mauvais fonctionnement par exemple).
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Description du menu « Data Log »

« LDCOM Data Log » (Intervalles du journal).
Utiliser cette fonction pour paramétrer l’intervalle de temps du journal d’un (ID spécifique) ou de tous les
appareils (ALL).
L’intervalle de temps peut être paramétré pour l’impression ou pour la sauvegarde sur PC.

La configuration peut être la même pour tous les appareils (identification de l’appareil : TUTTI) ou
différente pour chaque appareil (identification de l’appareil : 0000x).

Appuyer sur la touche « Upload » pour sauvegarder la configuration du journal dans la mémoire du
LDCOM.
Appuyer sur la touche « Download » pour recevoir la configuration depuis la mémoire du LDCOM.
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Description du menu « Log File »

« Upload Log File » (Chargement du fichier journal).
Utiliser cette fonction pour charger l’archive des journaux dans la mémoire du LDCOM. Il est possible de
spécifier une période de temps (Filter Enable) pour laquelle afficher le journal d’un (ID spécifique) ou de
tous les appareils (ALL). Appuyer sur «  Stop uploading » pour interrompre la procédure de téléchargement.

« Open LogFile » (Ouvrir fichier journal).
Utiliser cette fonction pour charger le journal des appareils enregistrés par le LDCOM dans un dossier
spécifique. Le dossier de chargement prédéfini du fichier journal est «  MasterComm ».
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« Graph Log File » (Créé un graphique à partir du fichier journal).
Utiliser cette fonction pour entrer dans la fenêtre Graphique du fichier journal.

Dans cette fenêtre, il est possible de paramétrer les critères du diagramme à dessiner : paramètres à définir
(consulter le manuel d’instructions de l’appareil pour une explication des sigles utilisés), intervalle de
temps et appareil spécifique (ID appareil) ou tous (ALL).
CH1 indique la mesure effectuée par l’appareil sélectionné.

Description du menu « Graphs »
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Description du menu « View »

« Tool Bar » (Barre d’outils)
Sélectionner ou désélectionner pour afficher ou masquer la barre d’outil présente dans la partie supérieure
du programme.

« Status Bar » (Barre d’état)
Sélectionner ou désélectionner pour afficher ou masquer la barre d’état présente dans la partie inférieure
du programme.
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Description du menu « Tools »

Cliquer ici pour changer le port de communication du modem installé

Cliquer ici pour un appel rapide (un numéro doit être spécifié)

Paramètres série.
Utiliser cette fonction pour choisir le port de communication sur lequel est installé le modem. Si un mauvais port est
sélectionné, MasterComm ne pourra pas communiquer avec le LDCOM ou l’appareil.

Connexion modem.
 Saisir le numéro à appeler et sélectionner le mode tonalité ou impulsions selon la ligne téléphonique utilisée. Appuyer
sur « Connetti » pour établir la connexion. Appuyer sur « Disconnetti » pour interrompre la connexion.

Cliquer ici pour configurer les entrées (In), les sorties (Out) et les compteurs

Cliquer ici pour afficher le débit instantané des compteurs

Archive des numéros téléphoniques

Ne pas utiliser. Fonction utilisée pour le test.

Ne pas utiliser. Fonction utilisée pour le test.
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WATER METER LDCOM (COMPTEUR D’EAU LDCOM)
En entrant dans cette section, il est possible d’afficher le débit instantané et le totalisateur des compteurs, si ces derniers
ont été paramétrés et si les entrées ont été activées (voir « IN/OUT Setup »).

IN/OUT SETUP (PARAMÉTRAGE ENTRÉE/SORTIE)
Cette fonction permet de configurer (activer/désactiver) les 4 entrées comme entrées standard ou comme compteurs et de
configurer (activer/désactiver) les 2 sorties.
Pour effectuer cette configuration, il est nécessaire de désactiver l’invitation, sauvegarder la configuration avec
« SAUVEGARDER » (« SAVE » et cliquer sur « APPLIQUER » (« APPLY ») pour transmettre cette configuration
au LDCOM.
En activant ce menu (IN/OUT SETUP), les DEL qui indiquent les états des entrées et des sorties
configurées apparaissent sur l’écran principal du programme MasterComm. Lorsqu’une entrée est activée
comme compteur, la DEL correspondante clignote. Lorsqu’une sortie est activée et que son état passe de
ON à OFF (et inversement), la DEL correspondante change de couleur.

Description du menu « Tools »
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Description des menus « Window » et « ? »

« New Instruments Status Window » (Nouvelle fenêtre états appareils).
Utiliser cette fonction pour ajouter une fenêtre d’état pour un appareil.

« Cascade » (Superposition,) « Tile Horizzontally » (Mosaïque horizontale), « Tile Vertically »
(Mosaïque verticale).
Utiliser cette fonction pour disposer les fenêtres dans la position décrite.

?
Choisir « About MasterComm » dans le menu « ? » pour contrôler la version du programme.
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CONNEXIONS INTERNES DE L’APPAREIL (BORNIER)

1 (Phase) ; 2 (Terre) ; 3 (Neutre): Alimentation (90÷240) VAC - 50/60Hz

4 / 5 (Contact libre de toute tension 3A resistivo) : Out 1

6 / 7 (Contact libre de toute tension 3A resistivo) : Out 2

8 / 9 (+) (Entrées en tension 12/24 VCC): In 1

10 / 11 (+) (Entrées en tension 12/24 VCC): In 2

12 / 13 (+) (Entrées en tension 12/24 VCC): In 3

14 / 15 (+) (Entrées en tension 12/24 VCC): In 4

16 (Masse, Noir) ; 17 (Tx, filo Rouge) ; 18 (Rx, Vert): Connexion au PC

19 (Masse, Noir) ; 20 (Tx, Rouge) ; 21 (Rx, Vert) ; 22 (DSR, Blanc): Connexion au modem

23 (Masse, Noir) ; 24 (Tx, Rouge): Connexion à l’imprimante série

25 (Masse, Noir)

26 (- ) ; 27 (+ ): Connexion en  série aux appareils série “LD”

Note :

F1 : Fusible 3,15 A retardé

COMPACT FLASH : Mémoire de l’appareil (ne pas toucher)

J1 : jumper RS485 (fermer si l’appareil est installé à la fin de la série)

Installation de l’appareil LDCOM

F1

COMPACT FLASH
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La ligne RS485 doit utiliser un câble de 600 Ohm type ligne téléphonique.

Pour chaque appareil, le câble entrant et le câble sortant doivent être connectés ensemble directement

sur les borniers 26-27, en respectant la polarité (FIG. 1). Le bornier 13 n’est pas utilisé.

Dans cet exemple, le LDCOM est situé à l’extrémité de la ligne donc le jumper (J1) doit être fermé (voir

bornier pag. 22).
Les appareils intermédiaires, deux dans cet exemple, doivent avoir le Jumper (J2) ouvert.

L’appareil se trouvant à la fin de la série doit avoir le Jumper (J2) fermé.

Tous les Jumpers (J1) des appareils de la série “LD” doivent être positionnés sur RS 485.

Les câbles de connexions ne sont pas inclus (ils doivent être commandés séparement).
Pour réaliser le câble de connexion au PC, utiliser un câble de transmission de données (max 50 mt)
connecté comme suit :
Bornier n. 16 au PIN 5 du DB9 femelle
Bornier n. 17 au PIN 2 du DB9 femelle
Bornier n. 18 auPIN 3 du DB9 femelle

Pour réaliser la connexion au  modem,  utiliser un câble de transmission de données (max 50 mt)
connecté comme suit :
Bornier n. 19 au PIN 5 du DB9 mâle
Bornier n. 20 au PIN 3 du DB9 mâle
Bornier n. 21 au PIN 2 du DB9 mâle
Bornier n. 22 non connecté

Connecter ensemble PIN 4, 7, 8 du DB9 mâle

Pour réaliser la connexion à l’imprimante en série, utiliser un câble de transmission de données  (max
50 mt) connecté comme suit :
Bornier  n. 23 à la masse sur l’entrée de l’imprimante en série (consulter le mode d’emploi de l’imprimante)
Bornier  n. 24 au signal sur l’entrée de l’imprimante en série (consulter le mode d’emploi de l’imprimante)

FIG. 1

Installation de l’appareil LDCOM

26 (-)  27 (+)

ROUGE

ROUGEBLANC
BLANC

LIGNE  RS 485 LIGNE  RS 485 LIGNE  RS 485

LDCOM LDxx LDxx LDxx
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Connexion directe PC – LDxx

Il est possible de connecter un appareil de la série LDxx directement au PC à l’aide d’un câble du type
« CAVOPC ». Brancher les trois fils comme suit :

Fil noir sur la borne 35 de l’appareil LDxx
Fil rouge sur la borne 36 de l’appareil LDxx
Fil vert sur la borne 37 de l’appareil LDxx

Mettre le cavalier J1 de l’appareil LDxx en position RS232 (voir le manuel de l’appareil).

Connexion « PC - LDxx »

mod. “CAVOPC”

LDxx
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Connexion « Modem GSM - LDCOM - LDxx »

Connexion Modem GSM – LDCOM – LDxx

Il est possible de connecter un appareil de la série LDxx au LDCOM et à un GSM à l’aide de la
connexion suivante et du câble de type « CAVOMD ».

Le câble qui sort du modem GSM est composé de 4 fils (noir, rouge, vert, blanc). Brancher le câble du
modem au LDCOM comme suit :

Fil noir sur la borne 19 du LDCOM
Fil rouge sur la borne 20 du LDCOM
Fil vert sur la borne 21 du LDCOM
Fil blanc sur la borne 22 du LDCOM

Paramétrer ensuite le raccordement entre le LDCOM et les appareils comme décrit précédemment.

mod. “CAVOPC”

mod. “CAVOMD”

LDCOM LDxx
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Tous les matériaux utilisés pour la construction de l’appareil et pour ce manuel peuvent être recyclés et favoriser ainsi le maintien
des innombrables ressources naturelles de notre planète.  Ne pas jeter de matériaux dangereux dans la nature ! Informez-vous

auprès des autorités compétentes sur les programmes de recyclage dans votre région !


